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Running Reports:  Submitting Report Requests 

 The steps to Submit a Report Request can be applied to any of the Oracle applications. 

 The list of Reports used for submitting requests will differ depending on the module and assigned responsibility. 

 The Parameters required for each report will differ among the reports. 

NOTE: The routine steps you will perform to run a report are: 

 Locate the Report function from your Home Page Main Menu and select Run to launch the application and 
display the Submit a New Request Window. 

 Select Single Request from the Submit a New Request Window. This opens the Submit Request window. 

 Use the LOV in the Name field to select a Report Name. The Parameters window automatically displays. 

 Enter the required Parameters, click OK to return to the Submit Request window. 

 Click the Submit Request button at the bottom of the window. 

 Requests window opens. Click the Refresh Data button periodically until the report completes processing. 

 Click the View Output button to view the report in a specific format for the type of report run. 
IMPORTANT: For more detail relative to the routine steps above, review the associated section in this document for 
clarification. 

 

Submitting Requests 

 Log on and select the Responsibility you will use to submit a report. 

 To select the reporting function, you may begin at: 

 The your Administrative Information System Home Page. 

 Or, the Navigator Window within the Application you are using. 

 Scroll through the list of functions and locate Other: Requests/ Run or a similar combination. 

 Depending on the Responsibility assigned to you, your Navigator function list may only have Requests/ Run. 

 Click the Run function.  

 The Submit a New Request window will display. 

 This window is used to select the report type.  

 You must indicate the type of report you want. 

 Single Request is the system's default allowing you to submit a single report. 

 Request Set allows you to submit a set of reports. 

 Most Department End Users will use “Single Request”.  To select it, click OK on the Submit a New Request 
window. 

 The Submit Request window displays.   

 This window contains three regions: 

 Run this Request... 

 At these Times... 

 Upon Completion... 

 Four buttons are available to manage the requests. 

 Copy...   located at the top of the window, allows you to use information entered for a prior request and then 
modify it as necessary.  Use this when you have to submit the same report frequently, but not on a regular basis. 

 The other three buttons, located at the bottom of the window. 

 Help (C)...  gives access to Oracle's application library. 

 Submit...  submits the request once all information has been entered. 

 Cancel... allows you to exit the window without submitting a request; close window is disabled. 
 

Run this Request… 

 Run this Request… region is used to select the report to run and determine its parameters. 
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 Name field - identifies the name of the report, report set, or program you wish to submit. 

 Click on the LOV indicator for the Name field to display a list of available Reports. 

 The list of Reports is specific to the application and can vary among users, depending on the assigned 
Responsibility. 

 You can use the Find field... on the Reports window to type additional information and click Find to locate 
the report you need. 

 To select the Report, highlight the Report name and click OK, or, highlight and double-click on the Report 
name. 

 

Parameters 

 The Parameters window automatically displays, when the Report is chosen. 

 The fields on the Parameters window will vary among reports.  

 Enter the required Parameters. 

 If a LOV indicator is available, use it to populate the field. 

 When the Oracle Calendar feature is not available for date windows, enter the date in Oracle date 

 format. (DD-MMM-YYYY or DD-MMM-RRRR). 

 Click OK on the Parameters window to return to the Submit Request window. 
 
Remember:  If several windows open simultaneously and become layered, click and drag the title bar of the top 
window to place it where you can view the windows in the background. 

 The Language field defaults to American English.  Accept the default. 
 

At these Times… 

 The next region, At these Times..., is used to set scheduling options for running a report. 

 The Run the Job field displays the system default, "As Soon as Possible". 

 The Schedule button on the right of this field is used to set different run times for the report.  

 Detailed instructions for scheduling a report are provided later in this module. 

 To run this report immediately, after submission, accept the default, “As Soon as Possible”. 
 

Upon Completion… 

 The last region, Upon Completion... is used to enter completion options for your report. 

 The "Save all Output Files" checkbox displays a checkmark.  This is a default setting.  Do not change it! 

 This box must be checked in order to view the output online.   

 All output files are saved for three days before being purged from the system. 

 

Submit to Concurrent Manager 

 When the Run this Request..., At these Times..., and Upon Completion... regions of the Submit Requests window 
are complete, click the Submit button to submit the request to the Concurrent Manager. 
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Running Reports:  Viewing Requests 

 Once report information is entered and the request is SUBMITTED, the Requests window displays. 
 

Requests Window 

 Several requests may be displayed in various phases and with various statuses. 

 You will use the Requests window to: 

 Monitor the request during the processing stage. 

 View reporting completion information. 

 Access report output online. 

 Submit another request. 

 Three buttons are displayed at the top of the form: 

 Refresh Data is used to refresh the data appearing in the Phase and Status columns. 

 Find Requests is used to display the Find Requests window and initiate a search for a previously submitted 
request.  

 Finding a previously submitted request will be demonstrated later in this module. 

 Submit a New Request... is used to begin the process for submitting a new request. 

 Submitted requests are displayed in the multi-record block. 

 The Phase and Status fields show the report’s progress. 

 Phase = Pending, Status = Normal 

 Continue clicking “Refresh Data” to monitor the reports progress, as displayed in the Phase and Status fields. 

 The backgrounds for the PHASE and STATUS fields are color coded to indicate specific circumstances and are 
identified as follows: 

 RED indicates the request completed with a status of ERROR. 

 YELLOW indicates the request completed with a status of WARNING or is currently INACTIVE. 

 GREEN indicates the request is PENDING or RUNNING. 

 WHITE indicates the request has completed with a status of NORMAL, CANCELLED, or TERMINATED. 

 When there are several requests in the queue, you may have to wait longer for the request to complete. 

 If you have other reports to submit, you may submit them at this time. 

 You may exit the window and continue with other work. 

 Or, continue to click "REFRESH DATA" periodically, until the request completes. 

 While the Phase equals Pending: 

 You may place the request on "hold" or "cancel" it by clicking the Hold Request or Cancel Request buttons 
at the bottom of the window. 

 After a report request has completed, the Hold Request and Cancel Request buttons will become 
inactive or disabled. 

 You may also View Details... or Diagnostics, by clicking the corresponding button at the bottom of the 
window. 

 When the Phase equals Completed: 

 Hold Request and Cancel Request are inactive or disabled. 

 View Details..., View Output, Diagnostics, and View Log… are enabled. 

 This Learning Cycle addresses View Output; the remaining actions are addressed in Appendix B. 
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View Output 

Special Notes:  

 The browser used during the preparation of this material was Internet Explorer.  If you use another browser, 
it will not look like the information contained here, but it will be similar. 

 Reports are opened and formatted using the OracleReports feature.  If you do not have this feature installed 
on your PC, contact your LAN administrator or call the Help Desk.   

 Reports can be formatted using Microsoft Word formatting features, until OracleReports is installed. 
Instructions are provided in Appendix A. 

 The first step to viewing a report online is to select the request from the Requests window. 

 Use the Up and Down Arrow keys on the keyboard to place the Current Record Indicator. 

 Once the report is selected, click the View Output button at the bottom of the window. 

 The Viewer Option window displays. 

 The system default for the Viewer field is Microsoft Word; accept the default to view the report. 

 The File Download window displays prompting you to Open or Save the report. 

 Click “Open” to view the report online. 

 The report displays in Microsoft Word.   

 To make the report easier to view, format the report using OracleReports. 

 From the Word Menu Bar, click OracleReports and select Landscape Compress. 

 When the Landscape Compressed option is selected, the information aligns under the column 
headings. 

 Since Reports are purged from AIS after three business days, you may want to SAVE a copy to disk. 

 From the File menu, click Save As 

 The Save As dialogue box appears. 

 Click the Save In:  Down Arrow and select the location where you would like the report to be saved. 

 At the bottom of the dialogue window, click in the File name: field and enter a unique name for the file. 

 The Save as type: field displays the system default Plain Text. This default (extension .txt) is 
 appropriate, but using it causes a conversion dialogue box to appear.  We recommend selecting 
 the Word Document option. 

 You also have the option to Print the report... 

 Click the Print icon on the Toolbar, or click the File menu and select Print, or press Ctrl+P on the keyboard. 

 The Print dialogue window will display.   

 Enter the desired printer settings; when complete, click OK. 

 Note: Not all printers are able to print Oracle reports.  If you have a problem printing the report, contact 
your LAN administrator. 

 Once you have saved and/ or printed the report, exit Microsoft Word and return to the Requests window. 

 Click the File menu and select Exit to leave Microsoft Word. 

 If you are using Internet Explorer as your browser, you will return to the Requests window. 

 If you are using a different browser, a blank browser window may display.  From the File menu, select Close 
to close the browser and return to the Requests window. 

 IMPORTANT: Be sure to choose "Close" from the File menu instead of Exit.  If you choose Exit, you will 
exit from the Oracle Application, as well as the browser. 

 

Running Reports:  Finding Requests after Exiting AIS 

 This document provides instructions for finding requests, if you choose to exit AIS while the request is processing. 

 You may also use this process to view the report at anytime prior to the report being purged. 

 You can "View Requests" from any window that has enabled View menu options. 

 To view requests previously submitted, click the View menu and select the Requests option. 
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 The Find Requests Window displays. 

 This window contains four options for finding requests.  You can select the option you want by clicking the 
corresponding radio button. 

 My Completed Requests.... all requests that have completed processing will display. 

 No additional data is required in the fields displayed. 

 To use this option, click the corresponding radio button and then, click Find. 

 My Requests in Progress.... all requests still processing will display. 

 No additional data is required in the fields displayed. 

 If no Requests are in progress, the Message Line at the bottom of the window displays the following 
message:  "Query caused no records to be retrieved." 

 To use this option, click the corresponding radio button and then, click Find. 

 All My Requests.... this is the default setting and the one most users will choose.  The other options are 
really for heavy users of the system that may have numerous reports running. 

 “All My Requests” will display all reports whether processed or not.  

 No additional data is required in the fields displayed. 

 To use this option, accept the default and click Find. 

 Specific Requests.... entering data in one of the fields will display requests specific to the information 
entered. The more parameters entered into the Specific Requests region, the more restrictive the search will 
be. To use this option, click the corresponding radio button, enter data and click Find. 

Running Reports:  Scheduling Report Requests 

 Oracle provides several options for scheduling reports.  To cover all the material in appropriate time intervals, the 
scheduling options were presented in three different learning cycles.  The first learning cycle provided instructions 
on how to schedule a report to run only “Once”, at a specific time. The second learning cycle showed you how to 
schedule report requests to run "Periodically" and the third learning cycle outlined the steps for scheduling a 
report to run "On Specific Days". 

 Oracle’s scheduling options are meant to save you time.  If you run a report often or on a specific day, you can 
schedule the report to run automatically, eliminating the need to submit a new request each time you need the 
report.  Scheduling reports to run in off-hours also saves system resources.  

 

Steps Prior to Scheduling  

 Before you schedule a report, you must have completed the following steps. 

 From the Navigator, selected the Requests/ Run function. 

 From the Submit a New Request window, chosen the Request Type, e.g. accept the default, Single Request. 

 From the Submit Request window, entered the Report "Name" and "Parameters". 

 If the above steps are complete, you are ready to schedule the request.   

 If necessary, you can review the above steps in Unit 2, Module 6, Learning Cycle 1: Submitting Requests.  
  

Scheduling Window Options 

 Run times for reports are scheduled from the At These Times… Region on the Submit Request window. 

 The Run the Job field defaults to "As Soon as Possible"; if this default is accepted, the report will be 
submitted to run once, as soon as the Concurrent Manager can schedule it. 

 Clicking the Schedule button, to the right of the “Run the Job” field, opens the Schedule Window. 

 The Schedule window contains one region: Run the Job... 

 The Run the Job... region is used to select one of the radio buttons to determine how often the report will run. 

 There are three options, other than, “As Soon as Possible” for scheduling a report. 

 Once... - allows you to run the report once, but on a specific day and time. 

 Periodically - allows you to schedule the report to run on a periodic basis. 

 On Specific Days - allows you to create a schedule selecting the specific days of the week or month on 
which to submit the report. 

  
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Scheduling Report Request - Once 

 To choose the Once option, click the corresponding radio button. 

 The Run At field specifies the date and time for the report to run and defaults to today's date and time. 

 To change the Run At field date and time, click in the field to display the LOV indicator.   

 Invoking the LOV indicator gives access to Oracle’s calendar, which you can use to change the date and 
time.  If preferred, you can type the date and time in the Run At field. 

 In Production, you will click the OK button at the bottom of the Scheduling window to apply the run options.  

 When you return to the Submit Requests window, click the Submit button to send the request to the Concurrent 
Manager.  

 

Scheduling Report Request - Periodically 

 To choose the Periodically option, click the corresponding radio button. 

 Reminder: Periodically allows you to schedule the report to be run on a periodic basis. 

 To schedule a request to run Periodically, complete the following steps. 

 Start At field - The "Start At" field determines the date and time of the first report submittal; it defaults to the 
current date and time.   

 To change the date and time, click in the Start At field; this displays the LOV indicator.   

 You can invoke the LOV and use the Calendar to select the date and time for the report to be submitted for 
the first time or manually enter the date and time. 

 End At field...  The End At field determines the date and time the report will be submitted for the last time. 

 When the Start At field is populated, the cursor automatically advances to the End At field and enables the 
LOV indicator. 

 Manually enter an End Date in Oracle date format or use the Calendar feature. 
 

IMPORTANT:  If left blank, the report will be resubmitted continually, according to the schedule, or until it is manually 
discontinued.  It is imperative that this field be completed.  At a minimum, this should be set for one year from the start 
of the schedule. If you know a date when it should logically stop, set the End At to that date/ time. 

 Re-run every - determines the period at which the report will be submitted.  This is actually a two-part field. The 
first field contains the numerical value for the period and the second field contains the type of period. 

 The first field defaults to "1".  You can choose to accept the default or type in a different numerical value. 

 To populate the second field, click the Down Arrow to the right of the field and select the period type. 

 Apply the Interval... this region allows you to determine when AIS begins the count for the next interval. There 
are two options:   

 From the Start of the prior run - is the default.  AIS begun counting the interval to begin the next report run, 
when the report began its prior run. 

 From the Completion of the prior run - begins counting the interval when the report completes its prior run. 

 Save this schedule – click on this checkbox to save a copy of the Periodically schedule to be used again later.  
Refer to the “Save this schedule” section for more information. 

 When the Periodically schedule is complete, click OK to return to the Submit Requests window. 

 From the Submit Requests window, click the Submit button to send the request to the Concurrent Manager. 
  

Scheduling Report Request – On Specific Days 

 Clicking the "On Specific Days" radio button displays the selection criteria for creating the schedule.  

 This option allows you to create a schedule for submitting requests on a specific day of the week or month 
for a specified duration of time. 

 Start At field - The "Start At" field determines the date and time of the first report submittal; it defaults to the 
current date and time.   

 To change the date and time, click in the Start At field; this displays the LOV indicator.   
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 You can invoke the LOV and use the Calendar to select the date and time for the report to be submitted for 
the first time or manually enter the date and time. 

 End At field...  The End At field determines the date and time the report will be submitted for the last time. 

 When the Start At field is populated with the Calendar, the cursor automatically advances to the End At field 
and enables the LOV indicator 

 If the “Start At” date and time is manually entered, press “Tab” to advance the cursor. 

 Manually enter an End Date in Oracle date format or use the Calendar feature. 

 Dates of Every Month:   This region specifies the date of the month the report will run.   

 Click on the desired date to select it. 

 Days of Every Week: In this area you can specify the day of every week the report will run. 

 Click on the desired day to select it. 

 Save this schedule checkbox – clicking on the box saves a copy of the schedule to be used again later. 

 When the “On Specific Days” schedule is complete, click OK to return to the Submit Requests window. 

 If you did not mark the schedule to be saved, click Submit to send the request to the Concurrent Manager.  

 If you clicked the ‘Save this schedule’ checkbox, then you are prompted with the save dialogue window.  
Follow the instructions in the next section, “Save this Schedule”, to continue. 

 
Save this Schedule 

 If you check the “Save this schedule” checkbox when creating a “Periodically” or “On Specific Days” schedule and 
then click OK on the “Schedule” window, the Save Schedule window will display, prompting you for a name and 
description for the schedule you are saving. 

 Enter a unique Name and Description for the schedule. 

 When complete, click OK on the Save Schedule window. 

 This action returns you to the “Submit Request” window; you would now click Submit to send the request to 
the Concurrent Manager for processing. 

 

Adding an End Date 

 If you are entering a schedule using the “Periodically” or “On Specific Days” scheduling option and you neglect to 
enter an End Date, when you click OK to apply the settings, a "Caution" window displays. 

 Since an "End Date" for the schedule was not specified, this window asks for confirmation of intent to 
process the schedule without an End Date. 

 When creating open-ended schedules, exercise caution.  If they are not manually cancelled, they may run 
far beyond their useful life span, taking up resources and creating extra paper for someone. 

 From the Caution window, 

 Click OK to continue and submit the schedule without an “End Date”; this is not recommended. 

 Click Cancel to go back and enter an  ”End Date”. 

 If you choose to “Cancel” and enter an “End Date” at this time: 

 You may be prompted with the “Save Schedule” window, if you previously chose to save this schedule.   

 Click “Cancel” on the Save Schedule window to close it. 

 You are returned to the Schedule window. 

 Enter an End Date, manually or using Oracle’s calendar feature in the “End At” field. 

 To save this schedule for use again later, click the “Save this schedule” checkbox. 

 Click OK on the Schedule window. 

 If you chose to save the schedule, the “Save Schedule” window displays.  If, when you initially created the 
schedule, you entered a name and description for the saved schedule, then those entries are re-displayed 
and no changes are necessary.  Click OK to return to the Submit Request window. 

 From the Submit Request window; click Submit to send the request to the Concurrent Manager. 
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Running Reports: Upon Completion… 

 You will enter completion options after you have selected the report name, entered parameters and if necessary, 
scheduled the report, as previously noted. 

 The last region, Upon Completion... is used to enter completion options for your report. 

 As previously noted, the "Save all Output Files" checkbox displays a checkmark.  This is a default setting.  Do 
not change it! 

 To populate the Notify field, click the Options button on the right. 

 The Upon Completion... window displays.   

 It contains three regions:  Layout, Notify the following people and Print the Output to 

 The "Notify the following people" region is used to select the people you want to notify, when the report is 
complete.   

 The employee's "Name" must be entered exactly as it appears in the system.   

 To save time, we recommend using the LOV to populate the field. 

 Click in the Name field, enter a few characters of an employee's LAST NAME and press Tab;  

 This will display a shortened LOV; highlight the name you want and click OK. 

 The Upon Completion… window reappears; the employee name you selected is now listed for notification.   

 Repeat the steps to enter additional names of people for notification. 

IMPORTANT: The Print the Output To: region provides different Printing options for the Central Business Offices.    
This region is not used by Department End Users.  Instructions for Department End Users to print reports are available 
in Unit 2:  Navigation; Module 6:  Running Reports; Learning Cycle 2:  Viewing Requests.   

 When all of your completion options are entered, click OK to close the Upon Completion window and return to the 
Submit Request window. 

 Click Submit to submit the request with the completion options you just entered. 
 


